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Microstation V8i For Civil Design 

Workshop Overview 
 

This is a Short overview of the enhancements included in Microstation V8i (Select Series I). Included in 

the topics covered in this training are the Microstation V8i enhancements that will benefit the civil 

designer and the new Civil Platform Toolset. Because of the limited amount of time available for the 

workshop the training will attempt to give the user an introductory knowledge of this new functionality. 

For more in depth understanding of the enhancements it is recommended the user attend courses 

specific to the toolsets as they are made available. 

The topics included in this course will combine Microstation V8i functionality enhancements with new 

Civil Platform (CP). It is important to understand the CP toolset while not a direct part of Microstation is 

included with Bentleys Civil Packages, Inroads, GEOPAK, and MX Road. While it is technically an “add 

on”, CP operates the same in the Microstation environment, regardless of what civil platform it is 

installed with. 

Below is listed the Topics covered grouped according to the relevant software the tools are included 

with. 

Microstation V8i 

 Task Navigation Enhancements 

 Geospatial Tools 

 Interoperability (GIS) 

Civil PlatForm 

 Civil AccuDraw 

 Geometry 

 Data Acquisition 
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Task Navigation 
 

Task Navigation made its debut in Microstation with the XM release. With the V8i edition Task menus 

have expanded to include additional features to enhance the original task concept. Like the XM Tasks 

the 8i Tasks allows Civil users to incorporate civil tools into tasks separately or in combination with basic 

Microstation tools. Both the Microstation and Civil add on tools can also work in conjunction with the 

newly released Civil Platform toolsets in these Navigation menus. These Civil Platform tools will be 

discussed later in the workshop. 

Enhancements to the Task Navigation System include: 

 Ability to use “Main Tasks” in conjunction with Tasks. 

o This allows users access to specific tools that can be set to be dependent on the current 

“Task Menu” 

 Improved manipulation of workflow design. 

 Ability to create context sensitive menus (Task and Context- IE right click). 

 Review Task Navigation Menus 

1. Open Microstation from the Desktop icon 

2. Open the file : C:\Data\MicrostationV8iFor Civil\Accudraw\Tasks. 

3. Review the Task Menu docked on the left side of the Microstation screen. 

 

 
 

4. Click on the Civil Geometry Task Menu… Notice the menu expands pushing the remaining Tasks 

down. 

  



 / 
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5. Click on the GEOPAK Suite Task (Note if GEOPAK Suite is not available you will need to activate 

GEOPAK from the main Menu : Applications > Activate GEOPAK)  

Note You will notice GEOPAK is designated as a workflow by the icon to the 

right of the task. Because it is a workflow this will open the GEOPAK Task 

as a separate tab stacked on the task Navigation menu. Also Notice the 

main tools update 

 
 

6. Open the Microstation Element Information dialog  (icon in the primary toolbar across the 

top of your screen). 

7. Move(stack) the Element Information Dialog into the task menu. This is done by moving the 

menu to the top of the task until a notch (tab) appears at the bottom of the Task menu. This is 

known as the “sweet spot”. 

A workflow Task is a 

collection of tools to 

be used to guide the 

user through 

completing a process 

or “task”. 

This could include a 

workflow inside a 

workflow. 
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Figure 1- Task Menus stacked 

8. Use the Pin icon  at the top of the task menu to “Pin” the tasks out of the screen space. To 

access the menus simply pass your curser over the tab pinned to the left side of the screen. To 

re-dock the task , simply re-click the pin on the task menu. 

 

  

Microstation Task navigation Menu allows for 

the stacking of various Microstation dialogs, 

and Civil dialogs. 

This stacking creates multiple tabs to access 

the menus. Task Navigation further enhances 

the user experience by allowing the user to 

“Pin” these tabs to the side of the screen 

collapsing the menus giving the user more 

screen space for design. 
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Context Sensitive Menu 
Anyone using a windows based application has come across a context menu, better known as “right 

click”. The context sensitive menu is a menu that appears to us when we right click with the mouse at 

times contains the most basic of tolls such as copy, paste or perhaps a frequently used tool in the 

application we are working in. V8i expands on this functionality by allowing the user to use what are 

known as expressions to set context Sensitive Menus. 

V8i’s Context menus stay one step ahead of the user by placing the tools needed for given tasks or 

situations. The example shown below shows the typical context on the right and the context on the left 

when a reference file is selected. 

 

 Review Context Sensitive Menu 

1. Right click in the Dgn file to expose the menu. 

2. Next open the Reference file dialog and check on the attached reference. 

3. Select the reference and right click. 

You will notice a new set of tools available to you for use with a reference file (including “Activate” 

that allows for in place editing of the reference). 
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Geospatial Tools 
 

Microstation V8i  continues to progress into more than a “CAD” environment. As technology moves 

forward V8i continues to expand to work with both existing and developing data types. On the civil side 

of infrastructure no one movement in the industry has been more pronounced over the past decade 

than the importance to communicate. In the civil world this communication relies heavily on Geospatial 

data. 

The ability to set up coordinate systems in the platform shared by Bentleys various applications allows 

the users in all disciplines to leverage data that otherwise would have the potential to be mishandled or 

perhaps overlooked.  

 Access the Geospatial Toolbar 

This lesson is intended to expose users to the base functionality of the Geographic toolbar. As we move 

into other Civil toolsets the user should quickly recognize the effect the geospatial toolset has in 

enabling the user to quickly and easily manage differing Geospatial related data. 

1. Open the Dgn File C:\Data\MicrostationV8iFor Civil\Workshop\Geospatial_001. 

2. Access the Geospatial Toolbar from the Main Menu: Tools > Geographic > Open as Toolbox. 

 
 

Tools from Left to right: 

 Select Geographic Coordinate systems 

 Global Positioning System 

 Export Google Earth (KML) 

 Capture Google Earth Image 

 Define Placemark Monument 

 Synchronize Google Earth View 

 Follow Google Earth View 

 Google Earth Settings 

 Play Camera Animation in Google Earth 

As you can see many of the tools relate to Google Earth and require access to the internet. For this 

reason we will discuss these however no exercises have been set up using these features. 
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Microstation Design Plane 
 

While this topic is not new to V8i, Advanced resolution has been around since the beginning. It is 

necessary to first understand that whether we set a coordinate system or not, every Microstation dgn 

uses a design plane. Perhaps you notice the point and line grid when a new file is activated. GEOPAK 

users may have run into “Synchronization Alerts” at times when the Microstation units did not match 

the GEOPAK units. No matter what Bentley civil software is being used it will benefit the user to work 

with synchronized units. This will allow point X,Y position stored in GPK or Alg files to match up with X,Y 

position of the Microstation Grid. 

 Review the Design Plane 

1. From the Geospatial_001.dgn access the “Working Units” Settings > Design File > (Category-

“Working Units”). 

2. Take Note of the Advanced Settings 

What is the Resolution set at? _______________________ 

3. Close the Design File settings dialog.  

 

Setting Coordinates 
 

In the next exercise the user will set the Microstation design plane to a coordinate system. Determining 

the coordinate system to be used does not require the user to be an expert with geospatial data. The 

user should however have an understanding of the different types of data to be used in the project. 

Most geospatial data will contain “meta data” this data allows the user to understand how the data was 

obtained, the accuracy of the data and most important for the user,  the coordinate system being used.  

V8i Geospatial tools allow the user to select from a library of coordinate system. Differing data types can 

be referenced and re-projected to the coordinate system assigned to the design. 
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 Defining Dgn coordinate system 

In this exercise the user will apply a coordinate system to the active design model. If graphic elements 

are present in the dgn assigning a coordinate system potentially could alter the design plave, thus 

effecting the scale of the elements. 

1. Continuing in the Geospatial_001,dgn, select the Geographic Coordinate System from the 

Geospatial menu, (far left icon) 

 

 

2. Select the From Library icon (from the Geographic Coordinate System Dialog (shown above). 

Drill down into the library folder as follows , Library > Projected > North America > United States 

of America >  Pennsylvania >  PA83-SF Pennsylvania State Plane, Southern Zone, US Feet. 

 

Note With the Design plane set to survey feet the coordinate system  in this 

case also uses survey feet so no further prompts are give. The 

coordinates are set. 

We will next be importing geospatial data including Imagery. With the Coordinate system set, we need 

to set our dgn to support georeferenced raster images. 

3. Access the Raster Manager from the Microstation preference dialog, Workspace > Preferences > 

( Category-Raster Manager). 

4. Select the Georeference tab and toggle on “Use sister file, if present, for Georeferenced files. 

5. Set the default unit settings to  

a. Sister File: 1 unit = 1 US Survey Feet 

b. Raster File: 1 unit= 1 US Survey Feet 

6. Click OK to close the dialog. 
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 Importing Data 

With the design file now set the user can begin to import and reference various data types. In the next 

exercise the user will attach a georeferenced TIFF image and also an ESRI shape file. 

1. From the Microstation Attach reference dialog attach the Parcels.shp 

C:\Data\MicrostationV8iForCivil\GIS_ShapeFiles\Parcels.shp. Set the attachment Method to 

Coincedent. “Open” (attach). 

2. Use the MS fit view command to view the attached recerence. 

3. Open the Raster Manager File > Raster Manager. 

4. From the Raster Manager dialog, attach the image File > Attach Raster> 

C:\Data\MicrostationV8iForCivil\Imagery\AOI2.TIF. 

5. Accept the attachment options answer NO to place interactively.  

This will allow the Raster sister file to be read and correctly scale and locate the image based of the 

world file residing in the same folder. 
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Civil design Tools 

 
The remainder of the workshop will focus on some new developments released with Bentleys Civil 

packages (Inroads, GEOPAK and MX road). Some of these were first released with the initial V8i release 

and the remainder to be part of Select Series One. 

V8i 

 Civil AccuDraw 

 Roundabouts 

V8i Select Series One 

 Civil Geometry 

 Data Acquisition 

Data Acquisition 
 

Data Acquisition allows the user to quickly import (aquire) various types of Data including, Raw Survey, 

ASCII, LIDAR, and DEM (Digital Elevation Models). The process requires virtually no set up and will 

leverage existing survey feature databases (Inroad , GEOPAK SMD)for symbology. As a result of the 

process all relevant data is used in the creation of a surface as part of the acquisition process. 

Currently this data model can be shared with Bentleys other civil applications. 

 Acquire Digital Elevation Model 

Building on the geospatial orientation of our previous workshop the user will next use yet another form 

of data (DEM). This data because it is spatially reference will provide surface information for the project. 

We will leverage what was learned in the previous exercises to set up file to hold the surface. This will 

then be referenced back to the original Geospatial_001.dgn. 

1. Open the design C:\Data\MicrostationV8iForCivil\Workshop\Data_Aquisition. 

2. Set the coordinate system.   

3. Select the From Library icon (from the Geographic Coordinate System Dialog (shown below). 

Drill down into the library folder as follows , Library > Projected > North America > United States 

of America >  Pennsylvania >  PA83-SF Pennsylvania State Plane, Southern Zone, METERS. 

 
4. Open Data Acquisition (DA) from the Task Menu. 
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5. Dock the DA dialog into the Task menu as shown in the previous exercise (Hint: Find the “sweet 

spot”). 

 
6. Use windows explorer to open the folder C:\Data\MicrostationV8iFor Civil\GIS_ShapeFiles. 

7. Drag the file “Wagontown_pa.dem onto the Data Acquisition dialog (as shown below). 

 
 



 Data Acquisition 
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Once dropped into the DA dialog the user will notice the DA tool immediately recognizes the 

data type. The DA Tool will read the coordinate system of the incoming data (in this case UTM-

18 N) and automatically target the Microstation Coordinate System. 

 

8. Change the Target to NAD83 Pennsylvania Southern Zone US METER. 

9. Click Accept on the Surface from Raster dialog. 

 
 

Note DA will process the Data. The length of time required to process the data 

will vary but should be < 1 minute. While the data is processing do not 

attempt to work on any other processes in Microstation. 

Once finished processing expand the DA Surface tree as shown below. 

 

10. Toggle on Hull, Major and Minor Contours. 

11. Fit view to view the surface. 
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12. Right click on the surface “Wagontown” in the DA Dialog and select create graphics. You should 

now be able to select the graphics. 

13. Close the file. 

 Reference Surface to Geospatial_001 

14. Re-open the file Geospatial_001. 

15. Attach the reference file DataAquisition.dgn (file with newly created surface). Use the 

Microstation Fit view command. 

You will notice the file does not align properly, this is because we used State Plane “FEET” to define 

our original design and “METERS” to define the Data Acquisition. We will need to re-project the 

reference to feet using the Geospatial tools. 

16. Open the Geographic Coordinate System tool. Tools > Geographic > Select Geographic 

Coordinate system. 

17. Use the To reference button to re-project the Data Acquisition file to the Geographic_001.dgn 

coordinate system. 
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18. Click Apply and close the dialog. Your reference should now appear with the parcels and image. 
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Working with Civil Geometry 
 

With our coordinates set up and the existing surface in place the user can now begin designing. The 

remaining lessons are not intended to give detailed instructions on the Civil Platform Geometry tools 

but rather to introduce the functionality and concepts of these tools. For time sake only an elementary 

use of some of these functions will be discussed. 

 

 Import Hz (Chains) from existing geometry. 

Civil platform strives to maintain the users investment in Bentley products by working with existing 

Geometry types regardless of the Bentley Civil toolset being used. 

1. From the Geospatial_001.dgn access the Civil Geometry Task Menu. 

 
 

2. Use the import Geometry command  (Q) . 

This will open a windows dialog where you can select GEOPAK job001.gpk. 

3. Toggle the curves, points and alignments and import. 
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Your geometry will now align with the file as shown below. 

 

 Use Offset Transition on existing alignment 

1. Select the offset transition tool  from the Geometry menu. 

2. Set a single offset to 24’ as shown below. 

Civil Platforms heads up display gives the user the prompts at their curser. 

3. Locate the Main road centerline element. 
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Microstation V8i For Civil 22 Oct-09 

Copyright © 2009 Bentley Systems, Incorporated 

 
4. Extend the line along the lower portion of the Main road. 

5. Use the Complex By PIs Command  and replicate the lower intersecting road . 

6. Key in the curve lengths as you place the PIs as shown below. 

7. Once place select the alignment. The user can then update any of the values shown by simply 

selecting the on screen dimension (OSD) and making edits. 

8. Use the offset Transition command again and create a 12’ offset.  
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13. Place the curb returns at the intersection of the new road and the existing road use the “Arc 

between Elements” command . 

14. Set a 25’ radius as shown below. 



Working with Civil Geometry 
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Follow the prompts on the screen to place the curb return. Once a CP element is divided the remainder 

ghosts out, however the element remain intact to use on the second return. The element will highlight 

when the curser touches it. 

 

 

Civil Platform tools were designed 

to be intuitive to the designer. 

Heads up display shows both 

commands and tool parameters. 

These same tool parameters can 

be accessed from the dialog and 

also tabbed through using the 

arrow keys on the keyboard. 
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With the simple roadway built the designer can now select the center line and update the alignment just 

created. Notice the edge of pavement elements move with the alignments. CP elements remember 

design intent allowing for some exciting possibilities in design.  
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Civil AccuDraw  
 

This workshop will focus on Basics of Civil AccuDraw. Prior to looking at the functionality of Civil 

AccuDraw the user will first look at Accudraw. The purpose of beginning with the original AccuDraw is to 

provide the user with a starting point of understanding of the functionality improvements working with 

AccuDraw gives us. This is by no means a complete overview of the original AccuDraw. 

AccuDraw Basics Create a Block 

 

1. Open the AccuDraw.dgn  (C:/ Data/MicrostationV8iForCivil/workshop) 

2. Activate AccuDraw from the Microstation Primary Tools menu. (The user should notice a 

AccuDraw input dialog floating or Docked. 

 
3. Select the Microstation “Place block” command.  

4. DP to an open place on your screen. A square compass should appear at the block DP. If the 

Compass is round hit the spacebar on your keyboard to change it to square (X,Y mode) 

Note: Notice Focus is now in the X field of the dialog. 

5. Key in 100 to the X field, use the “Tab” or “enter” key to move to the Y field and key in 100 hit 

“Enter” 

6. DP to accept the 100x100 block. 
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Use the Calculator to Place a Line between Elements 
 

The next exercise will involve placing a line at the center of known points. In our example the ROW 

varies but the proposed Road center will remain evenly spaced between the Right of Way (ROW). 

Some things to keep in mind: 

 DP = Data point 

 Tentative snap- This is accomplished by clicking the left and right buttons of the mouse together 

to lock on to a position (Note this function can be reconfigure to the mouse wheel or other key 

if desired) 

 “O”  Key-In: This key In represent s the Origin of placement, or origin of measurement for 

AccuDraw 

 “N” Key –In: This represents the “Near point Snap” it will allow us to snap to the nearest design 

element. 

 

Begin the workshop by accessing the saved view “centerline”. (Utilities>saved views) 

1. Access your smartline tool from Microstation. 

2. Change the AccuDraw mode to polar (click the spacebar) you will now have a round 

compass and can input distance and angle. 

3. Tentative snap to the upper side of the ROW as shown below. 

 

4. Use the “O”shortcut on your keyboard. This will activate the origin shortcut. (You will see 

the circular compass appear at the location you were snapped to). 

5. Use the “N” shortcut on your keyboard. This will allow you to lock on to the nearest element 

perpendicular to the first DP(Do not snap). 
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You will now see the distance and angle updating as you move along the element you are 

locked onto. 

 

6. With the focus in Distance dialog click the “/” and enter 2. Click Enter. This will activate the 

calculator shortcut for division dividing your current length by 2. 

7. DP to accept the position at this distance. 

8. Extend the SmartLine to where the upper ROW transition has ended (as shown below). 

9. Tentative snap to this location. 

 

10. Repeat the process above by using the “O” shortcut then the “N” shortcut to “lock” on to 

the lower ROW element perpendicular to the tentative snapping point. 

11. Use “/” to divide by 2 in the AccuDraw Distance dialog (remember to click ENTER). 

12. DP to locate the line location. 

13. Extend the line to where the ROW begins to widen to the lower side of the ROW. 

 

You should now be able to repeat the steps above to complete the CL to the end of the 

ROW by snapping to the ROW elements where they change direction.  
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Accessing Civil AccuDraw 
1. Microstations Original AccuDraw has been configure to activate on opening of your .dgn. To 

avoid conflicts between Civil AccuDraw and AccuDraw it is recommended only one be active at a 

time. For this lesson be certain to de-activate AccuDraw. 

2. For this Workshop Any Dgn can be used. We will however continue in the open 

“AccuDraw.dgn”. 

3. Opening AccuDraw can be accomplished using several different methods. Microstation V8i  

works with a unique “Task Configuration” Menu Structure. Both AccuDraw and Civil AccuDraw have 

the ability to work off Key-in commands. This allows for a great deal of customization by setting 

these key-ins to Task tools. These Key ins can also be set to function keys allowing us to activate and 

de-activate the utility with these keys. We will look at these customizations in further detail later in 

the chapter. 

4. By default Civil AccuDraw is delivered accessible through our tools menu. Unlike the original 

AccuDraw delivered with Microstation it must be activated! 

5. To open the Civil AccuDraw toolbox, go to Tools > Civil AccuDraw 

This will open the toolbox 
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 Toggle AccuDraw on/off 

 Drop down list of various tools including AccuDraw settings and common shortcuts.  This drop-

down is also available by pressing space bar when any AccuDraw field has focus. 

 

These are the ordinate systems delivered in a default installation.   

Distance – Direction 

Distance – Direction with two origin points 

Distance – Distance 

X – Y 

Dx – Dy 

Station – Offset 

The user can add more methods as needed.  We will demonstrate how, later in this exercise. 

If the DGN model is a 3D model then you will also have 2 additional icons to set the elevation ordinate to 

Z or Dz.  We will focus only on 2D for this exercise. 
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Civil AccuDraw Settings 

1. Click the settings icon.  

 

The operation tab of settings is the same as settings for MS AccuDraw and performs the same functions. 

Display Settings 
 

At first glance the Display settings offer the user little to get excited about, however one must consider 

the makeup of the AccuDraw Compass Setting symbology to the different compass modes will 

dramatically increase the ease of use. 

Consider the parts of the compass shown below. 
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Display preferences allow the user to set different display modes when distances and direction are 

locked. This gives the user immediate visual feed back when locating, positioning and modifying.  

Shown below the compass has been locked to a distance. The distance Circle color changes from gray to 

red letting the user know that the distance input is locked to the circle. The user can set any color 

combinations to alert them to these types of changes.  

The Direction Plane can also be set to display a “Locked” color, additionally a Highlight color can be set 

to highlight as the direction plane crosses the Axis. 

 

 

2. The display tab contains settings for: 

 Color of compass 

 Points = how many compass point (IE axis lock points) default is 4 maximum is 400. 

 Color of the constraint lines 

 Whether you want to see the constraint lines and color of the constraint lines 

 Color and transparency of the floating dialog. 

 The shortcut button brings up the same shortcut list as used by MS AccuDraw. 
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3. Set the display settings as shown below. 

6.  

Note Civil AccuDraw uses the same shortcut.txt file as MS AccuDraw. 

 

4. The coordinates tab contains the same round off and indexing settings as MS AccuDraw and they 
function the same way.  Two additional settings are provided to allow round off of station and offset 
values. 
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5. The favorites tab is major new piece that differentiates Civil AccuDraw from MS AccuDraw. This is 
where we configure our most commonly used ordinate systems. 

6. Let’s add a new favorite to this list.  Click the Add button. 

 

7. Type a name for the new favorite “Offset-Offset Unlinked” 

8. Select Ordinate 1 to be Offset.  Ordinate 2 to be Offset 

9. In the “Common Origin” column choose “No”.  The icon is selected automatically. 

10. Most of these settings are probably self explanatory with the exception of the “Common Origin”.  
This column refers to whether the two ordinates are measured from the same origin (Yes) or from 
different origins (No). 

11. This new ordinate method will provide ability to locate a point by offsetting from two different 
alignments (as shown below). 
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7. And the AccuDraw tool bar will now have an additional icon. 
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Getting Started Civilized 
 

Workshop- Place Block 
 

1. We will begin this lesson by selecting the “Getting Civil-ized design model inside our 

Accudraw.dgn 

2. Access your Civil AccuDraw toolframe. Use your Function Key to activate Civil AccuDraw. 

 
3. Select the XY Ordinance and create a block 1000 X 1000 by entering the dimensions in the Heads 

up display. 

4. DP to accept. 

The user is now on their way to some way cool stuff! Before getting started take note of the Key ins 

and terminology below: 
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Using Distance and Direction Ordinance 
Drawing lines in a design is a common task; you will now add precision input to those lines with the 

distance direction Ordinance.   

1. Make sure AccuDraw is active.  If it is active then the first icon in the toolbox will have an orange 

background. 

2. Set the active symbology to a heavy line weight and a vibrant color that is easy for you to see.  

Say, red and line weight of 6. 

3. Start the smartline tool and click the first DP anywhere on screen. 

7.  

4. You will immediately notice some differences from the Microstation AccuDraw tool. 

a. As civil designers, direction is key, so the Civil AccuDraw compass designates North with 

an arrow regardless of view rotation.    

Civil AccuDraws heads-up on-screen prompt allows precise key-in of distance 

and direction.   
Note We will use this interface for this exercise, but you can press the down 

arrow key to switch to a fixed dialog box 

b. Civil AccuDraw has so many combinations of ordinates that providing useful feedback 

through compass shape was not effective. 

c. The distance and direction present a circle and line feedback for the constraints.  

Note This can be disabled as we’ll see later 

Civil AccuDraw Onscreen 

feedback will change 

depending on the 

ordinance being worked 

with. 
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5. Key in a distance and then enter to lock the distance.  As discussed in the prior chapter you will 

note that the constraint circle changes color to provide additional feedback that the value is 

locked. 

8.  

6. Move the cursor so that the direction is near one of the compass points (north, south, east or 

west) and note that the color change feedback is also present when a compass direction locks. 

9.  

Note To unlock a value use the END key. 
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7. Now lock the distance to an arbitrary value.  Note that the direction line also changes color to 

show the locked status. 

10.  

Note The direction format follows whatever is configured in the DGN settings for 

angle readout. 

8. DP to set the next vertex.  Note that the context sensitive rotation of the compass behaves the 

same as MS AccuDraw.  IE, the compass rotates relative to the first line segment.  Note 

however, that the north arrow remains pointed north. 

Note Consistency with MS AccuDraw was a major consideration when 

designing Civil AccuDraw.  It is the express intent to preserve as much of 

the same behavior as possible to make the transition to Civil AccuDraw as 

easy as possible. 

11.  
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A Look At The Ordinances 
 

Thus far we have used the distance Direction and The X,Y Ordinance. Below is an outline of some of the 

function of various other ordinances. This is not a complete list. 

Distance Direction “Unlinked” 

 

This Ordinance allows the user to locate 2 known points using the compass origin “O”. A distance can be 

set from one origin while the direction can be set from the second origin “O”. 

1. Select the Distance Direction unlinked Ordinance from the tool bar. 

2. Select the Cell BM 

3. Tag “O” origin DP to a known point (we will use the bottom left corner of our block). 

4. Key in a distance (300’) click enter to lock… 

5. Click “O” to set the second origin. 

6. Locate the second known point that the direction will be taken from (click to the midpoint of 

the right side of the block). 

7. Tab to the direction field and key in S40:22:12W, tag Enter. This will lock the angle at 229.63 

degrees… and locate the cell at the intersection of the distance and bearing.  

8. DP to accept the cell location. 
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Distance Distance 

 

Distance Distance allows us to set two origins and specify distances from these 2 known points  the 

resulting intersection (s) of these distances indicate our new origin. 
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Station Offset 

 

For the last two Ordinances we will use the default design model in the Accudraw.dgn. 

Station Offset allows us to identify an element or alignment and locate our point or line origin to a 

specific station and offset. 

For this exercise we will work off the centerline we placed at the start of the workshop. 

1. Open the default design model in the MS Accudraw.dgn 

2. Select the Station Offset Ordinance 

3. We will place another BM cell- select your cell 

4. To set the “Baseline Origin” we need to tag “O”. This will allow us to select the alignment 

element. (Note with future release of CP Geometry this function will read the stored stationing) 

5. Set the station to 1+00 and the offset to 40’. 

6. DP to set cell. 
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More Cool stuff 
 

To this point we have been primarily been creating new lines and point. As we pointed out earlier the 

same functionality can be used to modify and manipulate existing points and elements. 

We should take some time to modify some existing elements using Civil AccuDraw. Consider a simple 

line extension. Civil AccuDraw allows us to lock on the line and with precision extend or shorten an 

element to an exact value. 

It will also work with the Fence and stretch function, as well as third party application such as COGO 

point placement, Lines etc. 

A look ahead will see Civil AccuDraw driving Civil Geometry tools Cool Stuff! 

 


